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2 Orbix Interview Questions And Answers

Orbix Job Interview Preparation Guide.

Question # 1
How to limit the connections to from a service?

Answer:-

QOrbix provides the following configuration settings to limit the number of connections to and from a service:
* plugins:iiop:incoming_connections:soft_limit

* plugins:iiop:incoming_connections:hard_limit

* plugins:iiop:outgoing_connections:soft_limit

* plugins:iiop:outgoing_connections:hard_limit

Read More Answers.

Question # 2
How to increase the internal logging in Orbix configure?

Answer:-

The itconfigure utility uses Log4Jlogging. Thisis configured in the propertiesfile:
<ORBIX_INSTALL_DIR>asp6.3 emplatesetclogdjlogdj.properties.

To configure debug logging level, change thefirst line of the propertiesfile from:
log4j.rootL ogger=ERROR, A1

to

log4j.rootLogger=DEBUG, Al

The above change writes debug logging to the console. The logging output can be redirected to afile by adding the following lines to the log4j.propertiesfile:
logDir = C:/temp

logdj.appender.A1.File=%{ logDir} /itconfigure.log

Read More Answers.

Question # 3
How you can configure Orbix logging?

Answer:-

Orbix logging is configured through the event_log filters. These sequences of variables set the logging level for each of Orbix's subsystem. For example, the
following configuresthe IT_POA subsystem to display only error messages:

event_log:filters=["IT_POA=ERROR"];

Similarly, the following sets the IT_POA subsystem to display only error messages and also the IT_PSS DB subsystem to display only warning, error and fatal
messages.

event_log:filters=["IT_POA=ERROR", "IT_PSS_DB=WARN+ERROR+FATAL"];

An asterisk can be used as a wildcard character, either to specify all subsystems, or all message levels. For example, the following configures the IT_POA subsystem
to display al messages:

event_|log:filters=["IT_POA=*"];

Similarly, the following configures all subsystemsto display all messages:

event_log:filters=["*=*"];

If unconfigured, a subsystem will display no messages.

Read More Answers.

Question # 4
How to configure the license of Orbix 3.3?

Answer:-

Orbix 3.3 uses alicense code, not alicensefile.

There are three product sets for Orbix 3.3, each with it's own license code: Java, C++, or OTS.

The licenses codes have the form: 00000000-11111111-22222222-33333333-44444444

When prompted, provide the codes to theinstaller.

If licensed Orbix commands like idl or orbixd fail to run, the license may have been entered incorrectly.
Toreinstall alicense code after the initial installation is completed, run:

UNIX:

Install_license <app> <license code>
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Windows:
License.exe <app> <license code>

Read More Answers.

Question #5
How you configure thread pool settingsin Orbix 6.3?

Answer:-

The variablesin the thread_pool namespace specify policies that configure multi-threading. This namespace includes the following variables:

high_water_mark

high_water_mark specifies the maximum number of threads allowed in the thread pool. Defaults to -1, which means that there is no limit on the maximum number of
threads.

initial_threads

initial_threads specifies the number of initial threadsin the thread pool.

Defaults to the low_water_mark thread limit (or 5, if the low_water_mark is not set).

low_water_mark

low_water_mark specifies the minimum number of threads in the thread pool. If this variable is set, the ORB will terminate unused threads until only this number
exists. The ORB can then create more threads, if needed, to handle the itemsin its work queue. Defaults to -1,which means do not terminate unused threads.

max

max sets the maximum number of threads that are available for IMS message processing.

max_gueue size

max_queue_size specifies the maximum number of request items that can be queued on the ORB's internal work queue. If this limit is exceeded, Orbix considers the
server to be overloaded, and gracefully closes down connections to reduce the load. The ORB will reject subsequent requests until there is free space in the work
queue. Defaults to -1, which means that there is no upper limit on the size of the request queue. In this case, the maximum work queue size is limited by how much
memory is available to the process.

stack_size

stack_size setsthe ORB's internal threads stack size. Thisis only available in the C++ ORB; the Java APl does not allow manipulation of the thread stack size.

Read More Answers.

Question # 6
How you can configure an Orbix domain to use the DNS network alias hosthame in |ORs for Orbix services?

Answer:-

When configuring the Orbix domain provide the "-multihome" switch to itconfigure command followed by the DNS network alias of the hostname, e.g.
itconfigure -multihome <network alias hosthame>
The IORs generated for the Orbix services configured in the Orbix domain will contain the "network alias hosthame" rather than the physical hostname.

Read More Answers.

Question #7
How you can configure an Orbix domain to use fully qualified host names rather than short host names or | P addresses?

Answer:-

When running itconfigure and creating the Orbix domain in non-GUI mode use the "-hostnamePolicy" parameter to specify the address mode policy for IORs. The
hostnamePolicy value can be one of the following:

ip (IP addresses)

localhost (‘localhost’),

localhost_ip ('127.0.0.1"),

long (fully qualified hostname),

short (unqualified hostname-the defauilt).

When running itconfigure and creating the Orbix domain in GUI mode use the "Address Mode Policy for Object References’ setting in the first step (Domain
Defaults) of itconfigure one of the above values can be selected.

Use the hostnamePolicy “long" for generating fully qualified hostnamesin IORs.

Read More Answers.

Question #8
How you can configure an Orbix domain to contain corbal oc references instead of IORs for the Orbix services?

Answer:-

Orbix can be instructed to publish corbaloc style references instead of 10Rs for the Orbix services through the "-corbalocs true" switch to the itconfigure command
line tool when configuring an Orbix domain.

When using the itconfigure GUI ensure to check the "Use Corbalocs' check-box in the itconfigure GUI. This setting is only available in the "Domain Details" step
when running the itconfigure GUI tool in expert mode (File->New->Expert).

Read More Answers.

Question #9
How you can close the client connection to the Orbix 3 daemon?

Answer:-

Orbix 3 clients do not automatically close the connection to the Orbix daemon. These connections need to be closed explicitly.
Orbix 3 Java providesthe IT_KEEP_ALIVE_FORWARDER_CONNECTION configuration variable which can be set to false in order to close the connection to the
Orbix daemon.

Read More Answers.

Question # 10
How to change the default Orbix client timeout?
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Answer:-

The variable that sets the timeout Orbix config is:
relative_roundtrip_timeout

Read More Answers.

Question # 11
How to download the Orbix products?

Answer:-
Product downloads are awailable through the Micro Focus EPD (Electronic Product Delivery) portal.

Read More Answers.

Question # 12
Does Orhix support Oracle JRockit Java Virtual Machine?

Answer:-
Any versions of Orbix do not support Oracle JRockit Java Virtual Machine.
Read More Answers.

Question # 13
Tell me does Orbix Web Services provide locator functionality for Web Services endpoints?

Answer:-
Orbix Web Services does not include locator functionality for web services endpoints.
Read More Answers.

Question # 14
How to developed the event service consumers and suppliers?

Answer:-

An event service supplier program performs the following actions:

1) Instantiates suppliers using the appropriate interface in module CosEventComm
2) Connects suppliers to the event channel

3) Sends event messages to the event channel

4) Disconnects from the event channel

An event service consumer program performs the following actions:

1) Instantiates consumers with the appropriate CosEventComm interface

2) Connects consumers to the event channel

3) Obtains event messages

4) Disconnects from the event channel

Read More Answers.

Question # 15
Does the Orbix have size limit for CORBA messages?

Answer:-

Orbix does not impose a size limit on the messages sent from Client to Server. The size of the message is influenced by how the application has defined the message
in the Interface Definition Language (IDL) used by the server and client.

Read More Answers.

Question # 16
Tell me does Orbix provide tool to remove surplus empty lines from an Orbix configuration file?

Answer:-

QOrbix does not provide any tools to remove empty or surplus empty lines from an Orbix configuration file.

Using a text editor for example Notepad++ (http://notepad-plus-plus.org/) with the TextFX plugin installed (Plugins->Plugin Manager->Show Plugin Manager and
install TextFX plugin), you can simply load the configuration file, mark all text (Ctrl+A), then select menu TextFX->TextFX Edit->Delete Surplus Blank Lines.
Thisremoves all surplus empty lines.

Read More Answers.

Question # 17
Will Orbix 6 support 1/O callback feature?

Answer:-

Because Orbix 6 has no equivalent to the Orbix 3 1/0 Callback functionality, you must migrate any code that usesit. Orbix 6 does not alow accessto TCP/IP sockets
or transport-level information, thisis not compatible with the Orbix 6 architecture.

Read More Answers.

Question # 18
Does Orbix 3 and 6 support Java 7?

Answer:-
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Orbix 6.3.6 isthe first Service Pack of Orbix to include support for Java 7. Support for Java 7 is provided for Orbix 3.3.12 in Q2 2013.

Read More Answers.

Question # 19
Does Orhix 3 support VOS (Virtualization operating systems)?

Answer:-
Currently Orbix 3 (release 3.3.10) is not supported on any virtualization platforms.
Read More Answers.

Question # 20
Does interceptor capture SSL handshaking errors?

Answer:-
It is not possible to capture SSL handshaking errors programatically in Orbix as this is handled by the SSL toolkit and will fail before the connection is established
and Orbix begins to pass the request through the interceptors in the binding list.

Read More Answers.

Question # 21
What soft_limit and hard_limit configuration settings apply for each Orbix process or for a sum of Orbix processes running in an Orbix domain?

Answer:-

These settings apply to each Orbix process for which these settings have been configured and not to the sum of Orbix processes running in an Orbix domain.
If these settings have been configured in the global configuration scope then these settings will apply to each process started in your Orbix domain.

Read More Answers.

Question # 22
Does server migration to new physical |P address also impact on Orbix?

Answer:-

By default IORs will contain the hostname of a machine. Using such an IOR will succeed without any problems since a hostname lookup will return the new IP
address.

Ensure IORs of the CFR, Locator, etc. contain hostnames rather then IP addresses. Use the iordump tool shipped with Orbix in order to inspect the hostname/port
contained in the IOR.

Read More Answers.

Question # 23
Does clients using Orbix 3.x talk to servers using Orbix 2000?

Answer:-
Orbix 3 and later versions of Orbix (such as Orbix 6) have "on the wire" compatibility. Orbix 3 uses I1OP (Internet Inter-Orb Protocol) as it's default protocol. Hence
an Orbix 3 client can speak to an Orbix 6 server and vice-versa.

Read More Answers.

Question # 24
Were Java Applets supported in Orbix 6.3?

Answer:-
Orbix 6.3 has not been tested to run with Java Applets and is unsupported.
Read More Answers.

Question # 25
How we can access to CORBA objectsin Orbix?

Answer:-

Clients can locate CORBA objects through the OrbixNames, which is Orbix's implementation of the CORBA Naming Service.
"OrbixNames allows you to set up groups of objects that can provide particular services to a client. When a client requests an object from a group, OrbixNames
selects an object using a random or a round-robin load-balancing algorithm. Y ou choose the algorithm associated with each group".

Read More Answers.

Question # 26
How you can accessto CORBA objectsin Orbix?

Answer:-

Clients can locate CORBA objects through the OrbixNames, which is Orbix's implementation of the CORBA Naming Service.
"OrbixNames allows you to set up groups of objects that can provide particular services to a client. When a client requests an object from a group, OrbixNames
selects an object using a random or a round-robin load-balancing algorithm. Y ou choose the algorithm associated with each group".

Read More Answers.

Question # 27
How you can access to Cobra objectsin Orbix?
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Answer:-

Clients can locate CORBA objects through the OrbixNames, which is Orbix's implementation of the CORBA Naming Service.
"OrbixNames allows you to set up groups of objects that can provide particular services to a client. When a client requests an object from a group, OrbixNames
selects an object using a random or a round-robin load-balancing algorithm. Y ou choose the algorithm associated with each group”.

Read More Answers.

Question # 28
How to set the ORB properties?

Answer:-

The ORB properties can be set in one of the following ways:
* Using the iona.properties file

* Using Javainterpreter arguments

Read More Answers.

Question # 29
What do you recommended for clients using the JDK ORB?

Answer:-

As SUN's ORB runtime cannot be used with Orbix applications, configure the JDK to use the Orbix ORB runtime instead by setting system properties
org.omg.CORBA .ORBClass and org.omg.CORBA.ORBSingletonClass to the appropriate values.

Read More Answers.

Question # 30
Can aclient use jdk orb to communicate with Orbix domain?

Answer:-

As SUN's ORB runtime cannot be used with Orbix applications, configure the JDK to use the Orbix ORB runtime instead by setting system properties
org.omg.CORBA.ORBClass and org.omg.CORBA.ORBSingletonClass to the appropriate values.

Read More Answers.

Question # 31
How you can retrieve the local |P address on client side within an interceptor?

Answer:-

OAccessing the local address on the client-side, e.g. in an interceptor can be achieved by using the following code:
CORBA::Object_var obj = orb->resolve_initial_references("I T_IPTransport");
if (CORBA::is _nil(obj))

{
self_addr = (const char*) 0;
return;

}
IT_ATLI2_IP:IPTransport_ptr ip_transport = IT_ATLI2_|P::IPTransport::_narrow(obj);
if (CORBA::is nil(ip_transport))

{
self_addr = (const char*) O;
return;

CORBA::String_var hostname = ip_transport->local_node_name();
IT_ATLI2_IP::IPAddressSeq var ip_addresses =
ip_transport->name_to_addresses(

hostname,

0,

IT_ATLI2_IP::PROTOCOL_TCP,

IT_UtcT::never()

)

IT_ATLI2_IP::IPAddress var ip_address = ip_addresses[0];
self_addr = ip_address->node _literal();

Read More Answers.

Question # 32
How to change the port of the Orbix Notification Service?

Answer:-

Yes, the port of the Orbix Notification service can be changed easily during the Orbix domain deployment process. Running itconfigure in expert mode allows you to
change the I1OP port of the Orbix Notification Service. For further information please see the chapter "Creating a Domain in Expert Mode" in the Orbix Deployment
Guide and the chapter "Managing the Notification Service" in the Enterprise Messaging Guide.

Read More Answers.

Question # 33

Are Orbix 6 libraries thread safe?

Answer:-

QOrbix 5 and Orbix 6 is designed to write multi-threaded (and single threaded) application from the ground up. However, the following describes in more details about
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et

Orbix thread safety:

All Orbix library public APIs are thread safe.

Per CORBA specification, add_ref/remove_ref operationsin theidl generated code is thread safe.

Regarding the rest of the generated code, Orbix IDL -> C++ code generator generates mappings for user-defined IDL types, as well as client-side proxy invocation
code (-base switch) and server-side servant dispatch code (-poa switch). The client-side invocation code and server-side dispatch code are thread-safe. The mappings
generated for user-defined IDL types are not thread safe for concurrent modification but are thread-safe for concurrent reads.

Read More Answers.

Question # 34
How you dump the Orbix configuration?

Answer:-

To get al the Orbix configuration for a domain, run the following command:

itadmin config dump

Thiswill work in both CFR and file based domains.

The output will look something like:

* plugins:it_arm_interceptors:shlib_name = "it_arm_interceptors’

* plugins:itrp:shlib_name ="it_itrp"

* pluginsitrp:live_time="2"

* plugins:it_mbean_monitoring:shlib_name = "it_mbean_monitoring"

* plugins:it_mbean_monitoring:ClassName = "com.iona. management.logging.mbean_monitoring.MBeanMonitoringPlugin”
* plugins:basic_codeset:shlib_name ="it_basic_codeset"

* plugins:basic_codeset: ClassName = "com.iona.corba.codeset.BasicCodeSetPlugln”
* plugins:iiop_tls:ClassName = "com.iona.corbaiiop.tls.|OPTL SPlugln”

* plugins:iiop_tls:shlib_name ="it_iiop_tls"

Read More Answers.

Question # 35
What is Orbix?
Answer:-

Orbix is a CORBA ORB (Object Resource Broker) - a commercial software product which helps programmers build distributed applications. Orbix is an
implementation of the OMG's (Object Management Group) CORBA Specification.

Read More Answers.

Question # 36
How are connections managed in Orbix Connect?

Answer:-

The Orbix Connect resource adapter is packaged as a standard J2EE Connector Architecture resource adapter archive (RAR) file, corbaconn.rar. The corbaconn.rar
file contains all the classes and resources that Orbix Connect needs to manage the connections between J2EE applications and CORBA systems. CORBA capabilities
are embedded within this RAR file and include a fully functional, pre-configured standal one client instance of Orbix, IONA's market-leading ORB.

Read More Answers.
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Middleware Most Popular Interview Topics.

1: Middleware Frequently Asked Interview Questions and Answers Guide.

2 MQSeries Frequently Asked Interview Questions and Answers Guide.

3: VisiBroker Frequently Asked Interview Questions and Answers Guide.

4 : Net Dynamics Frequently Asked Interview Questions and Answers Guide.
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